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Chapter 1 

Using Numbers for Names and 

Measurements 
We use numbers every day for phones, addresses, quantities, and prices. When numbers are assigned to 

describe objects, events, or concepts and then combined with logic to infer relationships the process is called 

quantitative reasoning. Qualitative reasoning uses relative comparisons that describe the quality of things. 

Making decisions about issues such as air pollution require people to think about the quality of air they 

breathe and its importance. Both types of reasoning are necessary. Qualitative reasoning helps us choose 

appropriate objectives and quantitative reasoning helps us achieve those goals such as setting air pollution 

levels measured in parts per million. This chapter serves as an introduction to using numbers as a quantitative 

tool to assist in decision making. 

Why do I need to know this? 

Qualitative reasoning can help us choose an objective but it is less useful for measuring progress or 

comparing alternatives when the choices are not obvious. Simply labeling alternatives as good or bad is too 

simplistic for real-world applications where all of the alternatives have both positive and negative qualities. 

Using numbers makes it easier to describe objectives and to make comparisons between them. To do this, 

you need to know how numbers are used as names and as measurements. 

1 Numbers as Names 

Learning Objectives 
1. Identify examples of denominate numbers. [1.1.1] 

2. Identify sequences of denominate numbers and identify underlying assumptions. [1.1.2] 

3. Rank objects or events using numbers and describe the assumptions used. [1.1.3] 

Numbers can be assigned to people in addition to their names to provide a unique identifier. When numbers 
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are used as names they are denominate numbers. A common example is the social security number (SSN). 

The U.S. government assigns this number to each person in the country to facilitate record keeping. The 

social security number consists of three parts that are separated by dashes, as shown in Figure 1.1. 

 

Figure 1.1. U.S. Social Security Number. 

The first group of three digits is the area number that corresponds roughly to the states and increases 

from east to west. (Social Security Numbers: The SSN Numbering Scheme ND) For example, 001,002, and 

003 are assigned to New Hampshire, 362 through 386 are assigned to Michigan, and 602 through 626 

represent California. (Stucture of Social Secuity Numbers ND)  If you know someone’s SSN, you can make a 

good guess about where they were born. This system was created before computers were available and the 

naming system was not designed for convenient sorting. Because it is part of the official identity of U.S. 

citizens, it can be used by unethical persons to represent themselves falsely as another person in order to steal 

or damage the other person's reputation, which is called identity theft. Because of this threat, people are 

reluctant to use their SSN for everyday identification purposes. Other numbers are assigned to individuals 

that are more compatible with computer systems such as driver's licenses, credit card numbers, and customer 

identification numbers. If you are a student, your school has assigned a student identification number in order 

to track your progress. When you register at a website, the company’s computer assigns an identification 

number to you and your Web browser stores it on your computer in a small text file called a cookie. 

Whenever you visit that website, your browser retrieves the identification number from the cookie and the 
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company’s computer can look up your registration information and a history of your activity on that site. 

Denominate numbers can be used to infer a sequence if certain assumptions are made and logic is 

applied. A common use of denominate numbers is for finding street addresses. If you assume the method 

used to assign the street numbers is similar to most cities in the U.S., logic can be used to infer relationships. 

For example, if you are driving along a street searching for a business and you know its address is 1013 

Maple, you might infer that you are getting closer if you see an address of 810 Maple followed by 900 

Maple. You might also infer that the business you seek is on the opposite side of the street from the first two 

locations. These inferences are based on assumptions that the addresses are sequential, that the distances 

between them are approximately equal, and that the even numbers are on one side of the street and the odd 

numbers are on the opposite side. If the search for 1013 does not succeed, you might examine the 

assumptions on which your logic was based to see if they are correct.  

Numbers can be used to make rough comparisons by using sequential numbers based on one 

criterion. For example, if we consider the four largest sources of energy from which electricity is produced in 

the U.S. and assign the numeral 1 to the largest source, 2 to the second, and so forth we would have the list 

shown in Figure 1.2. 

 

Figure 1.2. Electricity Sources in Rank Order. 

In this example, numbers are used to indicate a rank order or simple rank. The underlying 
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assumptions used to create this rank order are that a common unit of measure was used for comparison and 

that measurements were from U.S. electric utilities. The weakness of rank order is that it does not indicate 

how different each item is from the other. For example, natural gas is ranked as number 2 but that does not 

tell us if it is almost as much as coal or far less.  

Key Takeaways 
 Denominate numbers can be used for personal identification such as a social security number, 

driver’s license, student identification, or customer number that is stored in a cookie by a Web 

browser. [1.1.1] 

 Denominate numbers can be used to indicate a sequence such as street addresses which are based 

on the assumptions that the addresses increase sequentially and that odd numbers are on one side 

and even numbers are on another. [1.1.2] 

 Assigning a sequence of numbers beginning with 1 to indicate how they compare on one criterion is 

called rank order. The rank is a comparison that does not indicate how much the items differ from 

each other. [1.1.3] 

2 Measurement Standards and Conversion Factors 

Learning Objectives 
1. Identify the two major measurement systems and their commonly used names or acronyms. [1.2.1] 

2. Identify and use appropriate conversion factors within and between systems. [1.2.2] 

Denominate numbers are used as units of measure but they can also imply a sequence. To use denominate 

numbers to infer a sequence, the user must know or guess the underlying assumptions. If there is widespread 

agreement on what numbers mean in a given context, it improves communication. The need to improve 

communiation led to the creation of standard measurement units for time, weight, distance, area, and volume. 

These standards developed piecemeal over long periods of time and were often arbitrary such as the length of 

the king’s foot (foot) or the span of a sailors reach (fathom). During the period when the British Empire was 

a global power, many countries adopted the British Imperial measurement system. As a former British 
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colony, the United States adopted this system with a few alterations. The U.S. still uses these old and 

arbitrary units for many of its every day measurements and the system is now known as the United States 

Customary System, which is usually called the American system. For example, a few of the units in which 

length is commonly measured in the American system are foot, yard, statute mile, and nautical mile. 

Similarly, area is measured in square feet, square yards, acres, and square miles. To use numbers for 

quantitative reasoning, it is necessary to compare numbers that represent measurements of the same units.  

For example, consider the following question; “If a solar panel is 15 square feet in area, how many 

would fit on an acre of land?” Before this question can be answered, one of the two units of area 

measurement must be converted so that they are both measured in either acres or square feet. The 

relationship between the two units of measure is called a conversion factor. For each pair of measurement 

units, there are two conversion factors. In this example, they are 43,560 square feet per acre and 

0.0000229568 acre per square foot. By using a conversion factor, the question can be revised to read: "If a 

solar panel is 15 square feet in area, how many would fit on an acre of land (43,560 square feet)?" The 

answer can be obtained by dividing 43,560 by 15 to deduce that 2,904 panels might fit on an acre. If you also 

knew the amount of electricity each panel could produce and its cost, you could begin to make meaningful 

comparisons between solar power and another option. 

A partial list of measurement units used in the American system that are often used in quantitative 

analysis of energy related issues is shown in Figure 1.3. 
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Figure 1.3. Conversion factors in the American System. 

Fortunately, with the widespread availability of the Internet, conversion factors are readily available. 

A particular conversion factor can be found by typing in a simple question into a search engine such as 

Google, Yahoo!, or Bing; or you can bookmark a site such as OnlineConversion.com in your Web browser. 

See Figure 1.4. 
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Figure 1.4. Websites provide convenient conversions for different measurements. 

Because of the difficulty in using measurement units that were challenging to convert, another system 

became popular. A French measurement system that was called the metric system was formalized as the 

le Système international d'unités (SI). Converting between units in this system is often as simple as moving 

the decimal place because they are multiples of ten as shown in Figure 1.5. 
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Figure 1.5. Selected conversion factors for SI. 

Because of the inherent simplicity of the SI measurements and the ease of converting between them, 

almost all countries use the SI measurements—even Great Britain. The same websites that provide 

conversion factors for the American system also provide conversion factors for the SI units and conversion 

factors between the American and SI units.  

To choose the correct conversion factor, it helps if you do a bit of qualitative reasoning before you 

look up the conversion factor. First, consider if the units into which you are converting a measurement are 

larger or smaller. Next, logically infer whether the result of the conversion would be a smaller or larger 

number. For example, if you convert three feet into inches you would first consider that an inch is the smaller 

unit so the result of the conversion should be a number larger than three. From this, you can infer that the 

conversion factor you want is a number larger than one. 

The next step is to choose the appropriate conversion factor. Most websites provide two conversion 

factors for each pair of units as shown in Figures 1.6 and 1.7. 
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Figure 1.6. Conversion factor used to convert inches to feet 

 

Figure 1.7. Conversion factor used to convert feet to inches. 

Because you have already decided that you need a conversion factor that is larger than 1, you know to 

use 12. The last step is to multiply by the conversion factor. 
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3 feet ∙ 12 inches per 1 foot = 36 inches 

(note: in this text, a dot, ∙, is used to indicate multiplication) 

If we apply this process to a more difficult problem, it becomes more apparent that you need a 

reliable method. For example, the highway speed limit in Canada might be 100 kilometers per hour. What is 

that in miles per hour? Because both speeds use the same time measurement (hour), we need to know which 

is larger, the kilometer or the mile. This is an example of one of the few facts that you need to memorize. A 

mile is longer than a kilometer. With this knowledge, you would expect that a speed in miles per hour would 

be a smaller number. The conversion factor to use is 0.621 as shown in Figure 1.8. In most cases, it is 

acceptable to round off the conversion factors to a few digits. 

 

Figure 1.8. Conversion factor used to convert kilometer per hour to miles per hour. 

Observe that the units of measure for kilometer per hour and miles per hour are often shortened by 

representing the units as a fraction such as kilometer/hour and miles/hour or with an acronym such as kph 

and mph. When the term “per” is used, it implies one unit of measure for the unit in the denominator. For 
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example, when we write 60 miles/hour it means 60 miles / 1 hour but the number 1 is not written—it is 

assumed. 

The result of the calculation is: 

100 kilometers/hour ∙ 0.621 = 62.1 miles/hour 

The following table is a list of a few qualitative facts about comparisons of measurement units 

between the American system and SI: 

Length 

 Centimeter is smaller than an inch 

 Meter is larger than a centimeter 

 Meter is larger than a foot 

 Mile is larger than a kilometer 

Volume 

 Gallon is larger than a liter 

Force (weight) 

 Pound is larger than a Newton 

 

Key Takeaways 
 The two dominant measurement systems are le Système international d'unités (SI) and the United States 

Customary System (American system). [1.2.1] 

 To convert between measurement units within the same system or between systems, first determine if 

the unit of measure you want to convert to is larger or smaller. Determine in advance if the conversion 

factor will be a number smaller or larger than one. From a website or list of conversion factors, choose 

the appropriate conversion factor that is larger or smaller than one and then multiply the measurement 

by the conversion factor. [1.2.2] 

3 Using Conversion Factors 

Learning Objectives 
1. Find and apply conversion factors for commonly used measurements of length, area, volume, 

speed, force, mass, energy, and power. [1.3.1] 

2. Document Web sources with comments. [1.3.2] 

3. Write basic formulas using mathematics symbols. [1.3.3] 
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4. Format cells with Comma Style and set decimals. [1.3.4 

5. Identify error messages and fix #VALUE! errors. [1.3.5] 

In this section you apply the concepts from the previous sections using Excel. In the following steps, you 

look up appropriate conversion factors from a website and paste them into a worksheet. 

1. Navigate to the folder where the files for this chapter are located. Open Ch01Measurements.xlsx. 

2. Save the file to your computer or memory device as Ch01MeasurementsStudentName.xlsx where you use 

your own name in place of StudentName.  

Tip: If your computer does not display the file extension, .xlsx, you do not have to type 
it. If you have Excel 2003 or older and your program does not open the file, go to 
Microsoft.com and search for the compatibility pack. Download and install it so you can 
use files created by newer versions of Word, Excel, and PowerPoint. 

 

3. At the bottom of the workbook, click the Conversion sheet tab, if necessary to select it. The first 

conversion has already been done as an example, as shown in Figure 1.9. 

 

Figure 1.9. 50 yards is converted to feet by looking up the conversion factor. 

4. Observe the red triangle in the corner of cell D5. It indicates the presence of a comment.  

5. Move your pointer onto cell D5. The comment appears as shown in Figure 1.10. The comment provides 

the Web address where this number was obtained. The name of the registered user of the computer is 

added to the comment automatically. When you add comments, a different name will appear. 
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Figure 1.10. Comment with source. 

6. Click cell E5. Observe that this cell contains a formula. All formulas in Excel begin with an = sign and 

the formulas use cell references or cell names rather than the number that is in the cell. The four basic 

mathematical operations use +   -  * and  /  that represent addition, subtraction, multiplication and 

division. The formula appears on the Formula Bar and the result of the calculation displays in the cell as 

shown in Figure 1.11. 

 

Figure 1.11. Formula. 

7. Next, you will copy a conversion factor from a website. Switch to your Web browser, and then go to 

onlineconversion.com. This website is divided into groups of conversion factors. Scroll down the list and 

click the Length/Distance group. Find the conversion factor for feet to yards by typing 1 as the quantity 

and selecting the From measure as feet, and the To measure as yards. In the Results box, drag to select 
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the number as shown in Figure 1.12. 

 

Figure 1.12. Conversion factor less than one with spaces used for separation. 

8. On your keyboard, press and hold the CTRL key, and then press C. This will copy the selected 

conversion factor to the computer’s clipboard. Observe the spaces used in the number.  

9. Switch back to the worksheet. Click cell D6. Press and hold the CTRL key, and then press V to paste the 

conversion factor into the cell, as shown in Figure 1.13. 

 

Figure 1.13. Conversion factor pasted into the cell but not yet entered. 
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10. Observe the spaces in the number. Because of the spaces, the program did not recognize this as a number 

and assumed it is text. On the keyboard, press the Enter key.  

11. Click cell E6. Type =A6*D6 and then press Enter. The program displays an error message, #VALUE!!  

Tip: When you type a formula in a cell, it is not set until your press the Enter, Tab, 
or an arrow key to move to another cell. You can also click the Enter button on 
the formula bar to leave the selection on the cell. Do not click in another cell 
because that action will cause the cell you click to be included in the formula. 

 

12. Observe the green rectangle in the upper left corner of the cell. This indicates a potential error in the 

formula. Click cell E6, and then move the pointer to the Error Checking button  that displays on the 

screen as shown in Figure 1.14.  

Tip: When you point at an Error Checking button it displays a message to describe 
the error. If you click the button it will give you alternatives for fixing the 
problem. In this case, the problem is the spaces in the number that was copied 
from the website. Because of the spaces, Excel treats this as text rather than a 
number, hence the "wrong data type" message. 

 

 

Figure 1.14. Error message explained. 

13. Click cell D6. On the Formula Bar, click the number to place the cursor in the Formula Bar. Use the right 

and left arrow keys and the Delete key to delete the spaces in this number, and then press Enter. The 

conversion factor is recognized as a number and used correctly in the formula. 

14. Click cell E6. On the Ribbon, on the Home tab, in the Number group, click the Comma Style button . 
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If more than two decimal places display, in the Number group, click the Decrease Decimal button  to 

round the display to show only two decimal places. 

Tip: When you decrease the decimals the original number still displays in the 
formula bar and is the number that is used in any formulas that use the cell. 
Decreasing the decimal does not round the value of the number, but only the 
number of decimals displayed in the cell. On worksheets the decimals displayed 
should be consistent within a column of numbers. The Comma Style and the 
Accounting Number Format both leave space at the right edge of the cell for a 
left parentheses in the event of a negative number. Use consistent formats so 
that numbers in a column display the same number of decimals and are aligned 
on the decimal point. 

 

15. Click cell D6. On the Review tab, in the Comments group, click New Comment. In the pop-up note, type 

From onlineconversion.com. Click another cell to deselect cell D6.  

16. Click cell D6. On the Review tab, in the Comments group, click Edit Comment. In the comment box, 

drag the name of the registered owner. Type your name, if necessary. 

17. Apply what you have practiced to complete the remaining conversions.  

a. On the Conversions worksheet, each section is separated by a gray bar and the heading in column 

A of each gray bar includes the name of the conversion group to use to find your answers. 

b. If you get all of your conversions from a single source, one comment to document your source is 

sufficient. If you use more than one source, identify the source separately for each conversion 

factor. You are welcome to use other sites than onlineconversion.com, particularly if they do not 

use spaces in their numbers.  

c. Use 1 as the quantity for all your conversions. 

d. Use formulas in column E to multiply the conversion factor in column D by the quantity listed in 

column A. 

e. Format the answers using the comma style, and only two decimals. 

18. Read the note in cell A47 about the conversion factors that you need to memorize. 
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19. Save your workbook. 

Key Takeaways 
 Use a website such as OnlineConversion.com to look up the conversion factor for lengths, areas, 

volumes, speed, force, mass, energy, or power. Copy the factor, and then paste it into a cell in the 

worksheet. Edit the factor to remove spaces, if necessary. [1.3.1] 

 Insert comments using the Review tab to provide links to websites or document sources of data or 

conversion factors. A red triangle in the corner of a cell indicates the presence of a comment.[1.3.2] 

 Begin formulas with an equals sign. Use cell addresses, numbers and mathematics operators such as 

+, -, *, or / for addition, subtraction, multiplication, or division respectively. Press Enter or Tab to 

set the formula. [1.3.3] 

 Apply Comma Style and decrease decimals consistently so that numbers in a column display the 

same number of decimals and align on the decimal point. [1.3.4] 

 Error messages are indicated by green triangles in the upper left corner of a cell. The Error 

Checking button offers solutions and the error message identifies the basic cause, such as for the 

#VALUE! error. The #VALUE! error occurs most often when the content of a cell is a word instead 

of a number. [1.3.5] 

4 Energy and Power 

Learning Objectives 
1. Describe the relationship between energy and power [1.4.1] 

2. Identify the common units of measure for energy in the SI and American systems. [1.4.2] 

3. Identify the common units of power in the SI and American systems. [1.4.3] 

4. Read residential electric and gas meters and determine the energy used per day. [1.4.4] 

Many people are confused about the difference between energy and power, which is understandable given 

the variety of measurement units. Historically, energy measurement units have been developed for dealing 

with each form of active energy and each type of stored energy. The difference in measurement units can be 

a formidible barrier to quantitative reasoning if you do not know how the units of electric energy compare 
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with other energy units. To overcome this barrier, you will become familiar with the most commonly used 

measurement units for energy and power. 

Energy Measurement 

Energy is not something that can be measured directly. We have to infer how much energy something has by 

measuring what it can do. For example, we have a good idea of how much energy can be obtained from a 

lump of coal by burning a sample of coal and observing the temperature increase it can cause in a sample of 

water. Fuels that are intended for use in heating are measured this way. The American system uses the British 

Thermal Unit (BTU), which is the amount of (heat) energy needed to increase the temperature of one pound 

of water one degree Fahrenheit. Coal is graded by how much heat energy it contains. For example, a pound 

of bituminous coal has between 10,500 and 15,500 BTUs per pound. This measurment is easy to use within 

its own realm. For example, if you wanted to increase the temperature of 100 pounds of water by 50 degrees, 

you would need 5,000 BTUs (100 ∙ 50). This  could be provided by somewhere between a half and a third 

pound of coal (5000/10,500 = 48%  or 5000/15,5000= 32%).  

The SI unit of energy is the Joule. It can be used for any form of energy. A BTU is larger than a 

Joule. The conversion factor is 1 BTU = 1,055 Joules. 

Both systems use the same unit of energy measurement for electricity which is the kiloWatt∙hour 

(kWh). A kiloWatt∙hour is much larger than a joule or a BTU. It equals 3,412 BTUs or 3,600,000 Joules.  

Energy can take many forms such as: 

 Heat 

 Motion 

 Light 

 Sound 

 

Energy can be stored in various ways such as: 

 Potential energy in a compressed spring 

 Gravitational energy (lifting something heavy to a higher location) 

 Causing a reversible chemical reaction that will give off energy (battery) 
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 Changing phase from solid to liquid or liquid to gas (water to steam) 

 Mass (nuclear energy; uranium or hydrogen) 

 

Power Measurement 

One of the basic laws of physics is that energy is neither created nor destroyed — it just changes form. When 

energy changes from one form into another, it is transformed. The energy used to power an automobile goes 

through several transformations:  

 In the sun, hydrogen atoms fuse together to make Helium atoms. In the process some of the 

mass is transformed into heat, motion, and light.  

 Some of the light from the sun hits the earth’s oceans where it is transformed into chemical 

potential energy by the chlorophyll in small plants. 

 The small plants are eaten by tiny living organisms and the energy is transformed into another 

form of chemical energy in molecules of oil. 

 The tiny organisms die and sink to the bottom of the ocean where they are covered with mud 

and evenually become trapped in rock and concentrated into petroleum. 

 A hole is drilled in the rocks to reach the trapped petroleum and it is taken to a refinery. 

 At the refinery, the petroleum is separated into various products including gasoline. 

 In a car’s engine, the chemical energy in the gasoline is transformed into motion, heat, and 

sound. 

 When the car stops, the energy of motion of the car is transformed into heat in the brakes. 

 The heat energy from the brakes and the energy in the exhaust gasses dissipate into the 

surrounding air. 

 The heat energy in the air is transformed into infrared light that radiates out into space. 

 

Energy can be transformed quickly or slowly. The chemical energy in a tree can be transformed into 

heat very slowly while the tree rots on the forest floor or it can be released quickly in a fire. If we consider 

the amount of time involved for the transformation to take place, we are talking about the concept of power. 

Power is the rate at which energy is transformed. The unit of power in the American system is the BTU per 

hour (BTU/H) and in the International system it is the Joule per second (J/s). Both systems use the 

horsepower for rating the power of engines and the kiloWatt (kW) for electrical power. 

Measuring Energy and Power 

We might use qualitative reasoning to decide that using less energy is a desirable objective but we need 

quantitative measurements to determine if we are making progress toward that objective and if the progress is 
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sufficient to reach the objective in the time available. Quantitative analysis needs numbers and measurements 

and one way to obtain them is to perform an inventory of the devices that use energy. This type of inventory 

is called an energy audit. An energy audit begins with gathering data. It includes a list of energy consuming 

devices, their power ratings, their hours of operation, and their locations. The energy they use can be 

calculated from their power ratings and the time of operation. Items that cycle on and off such as refrigerators 

are more difficult to estimate because the time of operation is varaible but those devices can be measured 

individually with small plug-in meters that record energy use, such as the one shown in Figure 1.15. 

 

Figure 1.15. Plug-in electricity use monitor. 

 A history of energy use is obtained from utility bills or from direct observation of the electric and gas 

meters such as the electric and gas meters shown in Figure 1.16.  
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Figure 1.16. Residential electric and gas meters. 

The meters have parts that rotate as electricity or gas passes through them. The spinning part is 

connected to the first in a row of small gears whose teeth interlock. For each full rotation of the first gear the 

next gear moves one-tenth of a revolution and the same relationship is true for each successive gear. In this 

manner, the rotation of the part within the meter can be expressed as multiples of ten. The gears rotate in 

opposite directions and so do the pointers connected to them. When the pointer is between two numbers on 

the dial, use the smaller of the two. If it is between 9 and 0, think of the zero as 10 and use the 9.To 

determine how much energy has been used, read the meter at two different times, and then subtract the 

previous reading from the present reading, as shown on the dials of an electric meter in Figure 1.17. 
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Figure 1.17. Reading electric and gas meters. 

Being able to read the meters allows a resident or business owner to experiment with energy saving 

strategies at intervals that are convenient and shorter than a month. The person could determine the energy 

used for a day under typical circumstances and then try using less energy the next day. By reading the meters 

before and after each time period, the electric and gas energy used during both days could be determined and 

the effect of the strategy determined. 

Determining Energy Used from Electric Meter Readings 

On the Electric worksheet, you will determine the kWh used based on three meter readings to determine if 

the energy use increased or decreased. If the intervals between meter readings are a day or so and they are not 

taken at the same time of day, the date and time should be recorded. Dates are stored as sequential numbers 

and time is stored as a decimal fraction of a day. The way dates are stored in computers is described more 

fully in a later chapter. 

1. In Ch01MeasurementsStudentName workbook, click the Electric sheet tab.  In cell B2 type today's date. 

Use the mm/dd/yyyy format; for example, May 21, 2011 would be 05/21/2011. (Note: The leading zero 

will not display for single-digit month numbers.) 

2. Select cells A6:A8. On the Home tab, in the Number group, click the Number Format list arrow and at 

the bottom of the list click More Number Formats. The Format Cells dialog box displays with the 

Number tab selected. 
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3. Under Category click Date, and then scroll the list and click to select the Date/Time format shown in 

Figure 1.18, and then click OK. This sets the format for the cells before you enter the dates. 

Figure 1.18. Date and time format selected. 

4. In cell A6, type 12/2/10 8:00 AM. In cell A7, type 12/3/10 11:00 AM, and in cell A8, type 12/4/10 8:00 

AM. The program stores days as whole numbers and time as a decimal fraction of a day. Eight AM is 

8/24 of a day which is 0.333 days. Dates and times can be subtracted to find the interval between them. 

Tip: To ensure that the dates and times display properly, it is important that there is a 
space between the date and time and between the time and AM or PM. If the spacing is 
not correct, Excel will interpret the entry as text and you will not be able to find the 
difference in time between the two dates. 

 

5. Examine the three rows of meters shown in Figure 1.19. The first row is the meter reading for 12/2, the 

second row for 12/3 and the third row for 12/4. Using the rules described previously, enter the three 

meter readings in cells B6:B8 for the three dates. 
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Figure 1.19. Meter displays for three dates. 

6. In cell C7, write a formula to determine the difference in the first two meter readings: =B7-B6. In cell C8 

write a formula to determine the difference between the second two meter readings: =B8-B7. If the meter 

readings in cells B7:B8 are correct, the differences will be 31 and 23. 

7. In D7 write a formula to determine the difference in amount of time for the first two days:  =A7-A6. In 

cell D8 write a formula to determine the difference in the amount of time for the second two days: =A8-

A7. 

8. In E7 write a formula to determine the number of kWh used each day by dividing the meter difference by 

the difference in the days: =C7/D7. Repeat this in cell E8 by typing =C8/D8. 

9. Select cells D7:E8. Right-click the selected cells and on the Mini Toolbar click the Decrease Decimal 

button  until only 2 decimals display. The energy used in the second interval between meter readings 

will be about approximately 1.2 kWh less per day. 

Tip: The Mini toolbar displays when you right-click selected cells. This toolbar 
displays most of the commonly used formatting tools and is a quick way to 
format cells rather than using buttons on the Home tab. 
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10. Save your workbook. 

Key Takeaways 
 Power is the rate of energy transformation. [1.4.1] 

 The American unit of energy is the BTU and the SI unit is the Joule. Both use kWh for electricity. 

[1.4.2] 

 The unit of power in the American system is the BTU/Hr and in SI it is the Joule/sec which is also 

called a watt [1.4.3] 

 The dials on a gas or electric meter represent units of consumption where the first dial on the right 

represents one unit and each dial to the left is a multiple of ten. The pointers rotate on opposite 

directions. When the pointer is between two numbers, use the lower value. To find the energy used, 

calculate the difference in meter readings, the difference in meter readings and then divide the 

difference in meter readings by the difference in time.[1.4.4] 

5 Analyzing Personal Energy Consumption with Excel 

Learning Objectives 
1. Use relative and absolute cell references in formulas to design formulas for copying and filling 

[1.5.1] 

2. Use the sum function to find the sum of a column or row of numbers. [1.5.2] 

3. Use the fill handle to copy a formula to other cells. [1.5.3] 

4. Identify totals using cell borders. [1.5.4] 

5. Format cells as percentages. [1.5.5] 

6. Display formulas [1.5.6] 

In this section, the energy used by a pair of adults who live in Michigan is analyzed using methods that can 

be applied to individuals, households, or small businesses. 

1. Refer to Figure 1.20 that displays a copy of a utility bill for natural gas service for the month of 

November in Southeast Michigan for a large, older home. Observe that the quantity of natural gas used 

was 141 CCFs. 

Tip: The natural gas industry combines Roman numerals with abbreviations in 
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their measurement units. The Roman numbering system uses C for one hundred 
and M for one thousand. CCF stands for one hundred cubic feet and MCF stands 
for one thousand cubic feet. 

 

 

Figure 1.20. Natural gas bill. 

2. In Ch01MeasurementsStudentName, click the Household sheet tab. Click cell B4 and type 141 and then 

press Tab to move to the right. In cell C4 type CCF. 

3. Click cell B4. On the Review tab, in the Comments group, click New Comment. A comment box displays 

with the name of the registered owner of the computer in the upper left corner.  

4. In the comment box, type Natural Gas use for November from utility bill as shown in Figure 1.21. If 

necessary, select the name at the beginning of the comment and replace it with your own name. 

 

Figure 1.21. Comment added to document source of data. 

5. Click another cell to deselect cell B4 and close the comment. Observe that a red triangle appears in the 

corner of the cell to indicate the presence of a comment. Move the pointer onto cell B4 to display the 
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comment. 

6. Refer to Figure 1.22 that shows the electric bill for the same residence for the same month. Observe that 

the electric bill consists of two parts—244 KWH for the hot water heating and 1035 KWH for the 

residential use. The electric water heater is connected to a radio-controlled device that allows the utility to 

turn it off when there is a shortage of generating capacity. They charge about a third less per kwh for this 

service 

 

Figure 1.22. Hot water heating billed separately from other electric uses. 

7. Click cell B5. Type =244+1035 and then press Tab. This basic formula adds the two values. In C5, type 

KWH and then press Enter. 

8. Use the skill you previously practiced to insert a comment in cell B5 using your name. The comment is; 

From utility bill for November; sum of hot water and residential bills. Refer to figure 1.23. 
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Figure 1.23. Formula and comment entered. 

9. In B6, type 50 and then in C6 type Gallons. Add a comment to B6 using your own name; Estimated four 

fill-ups of 12.5 gallons in November 

10. In B7, type 150,000 and then in C7 type Food Calories. This estimate uses a website named ShapeFit that 

provides food calorie estimates. 

11. To B7, add the comment; Assumes two people eating 2,500 calories per day for 30 days; Estimate from 

http://www.shapefit.com/dailycalorie-calc.html 

Tip: Food is a form of energy stored in the chemical bonds between atoms and 
molecules. The food calorie is a unit of energy measurement in the American 
system that is based on an old metric system measurement where 1 calorie is the 
heat it takes to raise 1 kilogram of water one degree Celsius. 

 

12. From OnlineConversions.com, copy and paste the appropriate conversion factors in column D and 

remove spaces as needed. 

Tip: Recall that the unit of natural gas is CCF which stands for hundred cubic feet. 

In the table, it might be alphabetized under H instead of C. 

 

13. Select D4 through D7. (D4:D7). Right-click the selected cells and on the Mini toolbar click the Comma 

Style button . 
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Tip: The abbreviated way to indicate a range of cells in a spreadsheet is to 
provide the cell names at the opposite ends or corners of the range. If the range 
is a rectangle of cells, the two cells are the ones at the upper left and lower right. 

 

14. In cell D4, insert a comment using your name: All conversion factors from www.onlineconversion.com. 

15. Click cell E4. Type =B4*D4 and then on the Formula Bar, click the Enter button, . Right-click the 

selected cell and from the Mini toolbar click the Comma Style button  and then click the Decrease 

Decimal button  two times. 

Tip: Formulas in spreadsheets are designed to be copied to reduce the effort it 
would take to type similar formulas many times. The program interprets the 
formula in cell E4, =B4*D4, to mean “use the value in the cell that is three cells to 
the left and multiply by the cell that is one cell to the left”. The references to 
cells B4 and D4 are relative cell references. 

 

16. With cell E4 selected, move the pointer to the lower right corner of the cell. Observe that the pointer 

changes into a plus as shown in Figure 1.24. The lower right corner of the cell is called the fill handle. 

 

Figure 1.24. Fill handle selected. 

17. Drag the fill handle down to cell E7. Click each of the cells E5, E6, and E7. Observe on the Formula Bar 

that each formula is different but they all refer to the two cells that are in the same relative position. 

18. Click cell E8. On the Home tab, in the Editing group click the AutoSum button, . The SUM function 

and its range are displayed, as shown in Figure 1.25. 
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Figure 1.25. Sum function adds a column of numbers. 

Tip: Excel has a library of programs that are called functions. The programs have 
names like SUM followed by parentheses that enclose the range(s) of cells that 
they use. The SUM program is one of the most commonly used so it has its own 
button on the ribbon. A complete list of these programs is displayed when you 

click the Function button  on the Formula Bar. 

 

19. Examine the range of cells that is indicated by the marque—moving dotted line—around the cells. 

Confirm that the range E4:E7 that is highlighted between the parentheses is the range you wish to sum. 

Click the Sum button a second time to complete the process, or press Enter. 

20. Click cell E8. On the Home tab, in the Font group click the Borders arrow. A list of cell borders displays. 

Move the pointer to the Top and Double Bottom Border option, as shown in Figure 1.26. 
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Figure 1.26. Top and Double Bottom Border option. 

21. Click the Top and Double Bottom Border option.  

Tip: The Top and Double Bottom Border is used to visually indicate a sum at the 
bottom of a column of numbers. 

22. Click F4. Type =E4/$E$8 and then on the Formula Bar, click the Enter button, . Right-click the 

selected cell and on the Mini toolbar click the Percent Style button, . Observe the formula in the 

Formula Bar. 

Tip: In column H, the intention is to design a formula that can be filled into cells 
H5:H7. In each formula, the cell to the left should be divided by the value in cell 
G8—not the value in a cell that is to the left one and down four cells. To lock in 
the reference to cell G8 so that it does not change as the formula is filled into 
other cells, its column and row references are preceded with a dollar sign. This 
dollar sign has nothing to do with currency. It is a historic relic of the early days 
of programming when dollar signs were used for other purposes. This locked 
reference is called an absolute cell reference. To save time typing, an absolute 
reference can be applied to a cell in a formula by pressing the F4 key on the 
keyboard. 
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Figure 1.27. Relative and absolute cell references used in a formula. 

23. On cell F4, use the skill you practiced previously to drag the fill handle down to cell F7. This calculates 

the percent of energy used for each purpose: heating, electricity, gasoline (transportation) and food. 

24. Click F7. Observe that the relative reference to the cell to the left is now E7 but the absolute reference to 

E8 is unchanged. 

25. Press and hold the Ctrl key and press the ` key (accent grave) one time. This key is located to the left of 

the 1 key on the numeric row. This keyboard shortcut displays the formulas for the entire worksheet as 

shown in Figure 1.28, which enables you to see the pattern and look for discrepancies. Alternatively, on 

the Formulas tab, in the Formula Auditing group click the Show Formulas button. 
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Figure 1.28. Relative and absolute cell references displayed in a formula. 

26. Press Ctrl + ` to redisplay the results. Save your workbook. 

Key Takeaways 
 Relative cell references change when a formula is copied or filled to retain the same relative 

relationship between the location of the formula and the cell to which it refers. Absolute references 

do not change when copied and always refer to the same cell.. [1.5.1] 

 The SUM function is a small program that adds the numbers in adjacent cells. It guesses which 

range to add and indicates the range with a moving dotted line called a marque. [1.5.2] 

 The content of a cell can be copied into adjacent cells by dragging the fill handle—the small square 

at the lower right corner of the selected cell. [1.5.3] 

 The total of a column of numbers can be indicated with a border that consists of a single line at the 

top of the cell and a double line at the bottom. [1.5.4] 

 A decimal fraction can be displayed as a percentage by clicking the Percent Style button in the 

Number group, or on the Mini toolbar. [1.5.5] 

 Display formulas by pressing the Ctrl key and the accent grave key (`). Alternatively, on the 

Formulas tab, in the Formula Auditing group, click the Show Formulas button. Repeat either action 
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to re-display the formula results in the cells. [1.5.6] 

Key Terms 

Absolute cell reference 

Cell reference in a formula that is locked to a particular cell and does not change when the formulas is copied 

or filled to other cells. 

American system 

Measurment system used in the United States that is based on the former British Imperial measurements, 

officially known as the United States Customery System. 

British Thermal Unit (BTU) 

Unit of energy used in the American system that is a measure of the amount of heat energy that will raise one 

pound of water one degree Fahrenheit. 

BTU per Hour (BTU/H)  

Unit of power in the American system. 

Conversion Factor 

Multiplier used to change from one measurement unit to another. 

Cookie 

Text file stored on a computer by the Web browser that contains an identification number. 

Denominate numbers 

Numbers used as names or with units of measure. 

Energy audit 

Inventory of devices that includes their discription, location, power rating, and hours of operation. 

Fill handle 

Small rectangle at the lower right corner of a cell which is used to copy or fill content from one cell the the 

next in a column or row. 

Horsepower 

Unit of power measurement used to rate the power of engines. 

Identity theft 

Impersonation of another person for fraudulent puposes. 

Joule 



   

 

Copyright ©2011 – John Preston Page 35 
 

Unit of energy in the SI system. 

Joule per second (J/s) 

Unit of Power in the SI system 

KiloWatt 

Unit of electric power in the SI and American systems. 

KiloWatt∙hour 

Unit of electric energy in the SI and American systems. 

Marque 

Moving dotted line. 

Power 

Rate of energy transformation. 

Qualitative reasoning 

Using relative comparisons to describe the quality of things.  

Quantitative reasoning 

Using numbers combined with logic to make inferences.  

Rank order 

Sequential numbers that indicate an order according to a criterion. 

Relative cell reference 

Cell reference that is defined in terms of its location to the left, right, up, or down direction from the cell in 

which the formula resides. 

le Système international d'unités (SI) 

System of measurment units used by most countries based on the former metric system. 

Social Security Number (SSN) 

Number assigned by the U.S. government for puposes of tracking social benefits programs. 

Transform 

Change forms of energy. 

United States Customary System 

Units of measure that are based on the former British Imperial measurements, also known as the American 

system. 
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